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LEADERS IN FINANCIAL MODELING SINCE 2002

e We believe that spreadsheet-based financial models are the most important
decision-making tools in modern finance

e We have developed a framework and discipline for model design, structure
and development that leads to best-in-class, user-friendly financial models

e We help finance professionals use this framework to turn their models into
powerful communication tools that lead to better, more effective decisions

The Marquee Group Offering
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CONSULTING

ACCREDITATION

v Instructors have real-world
experience and a passion
for teaching

v Topics include: Modeling,
Valuation, Excel, VBA,
Power BI, Python

v' Courses are interactive

v Clients include banks,
corporations, business
schools and societies

v’ Services include:

Model Development
Model Re-builds

Model Reviews and Audits

Dashboard and Report
Design

v' Clients include a wide
range of companies in
various industries

v Offered by the Financial
Modeling Institute (FMI)

v The FMI was established
by The Marquee Group and
ModelOff

v FMI administers official
exams for three levels of
financial modeling
certifications
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The Financial Modeling Institute

g
FMI

AUV

FINANCIALMODELING

SKILL VALIDATION

+ Demonstrate financial modeling proficiency to employers and clients

PERSONAL DEVELOPMENT

« Earn certifications that are challenging and revered by the industry

CAREER FLEXIBILITY

« Verify skills that are globally relevant and respected in many industries

LEVEL 1

LEVEL 2

LEVEL 3

-

v" Foundational level of certification
program

v" Proficiency in building beginner-to-

intermediate financial models

.

\

(~/ Attainable following successful
completion of Level 1
v" Thorough understanding of real-world
applications of financial modeling

~

(\/ Highest level of accreditation achievable
v' Expert in the end-to-end financial
modeling value chain
v" Respected thought leader, mentor, and

v' Skills in design and comprehension of v" Demonstrated ability in advanced Excel, contributor to financial modeling
finance, business, accounting and Excel financial analysis, and financial education
/ \ modeling / \

~

J

EACH LEVEL IS RECOGNIZED AS ITS OWN QUALIFICATION
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Agenda

Morning Topics
Designing and structuring a financial model
Developing the inputs and assumptions pages
Building powerful scenarios

Afternoon Topics
Creating the financial statements
Incorporating all relevant schedules
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What is a Financial Model?

e The integration of technical skills with business / academic skills to

create user-friendly decision-making tools

TECHNICAL BUSINESS
SKILLS SKILLS

Excel Functions Accounting
Design - Finance

Logic Engineering
Presentation Statistics
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Modeling Discipline

e A good model needs to be a powerful communication tool so that it can
be used to make effective decisions

e The following are important attributes of a strong financial model:

1.

6.

2
3
4,
5

Dynamic
Flexible
Intuitive
Printable
Transparent

Transferable

e When a model achieves the criteria above, it creates tremendous
credibility for the builder and inspires confidence with the reader.

e It is also much easier for someone to take ownership of a model that
meets the criteria above.
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Modeling Basics

o Keep it simple
e NEVER HARDCODE!

- Always enter inputs as a different colour than calculations
- Never enter a formula that looks like:
=A5 * .025 + 4.9

e Use the keyboard to increase speed

e Label everything properly (even excessively)
e Everything should be printable

e Master the basics

e Become an expert at formatting

e Practice
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Formatting

Debt/ EV / EBITDA Return on Equity
Price Mkt. Cap. Capital LTM 2020 P/ BV LTM 2020
Group 1
Company 1 14.05 2679.335 0.4343 11.2327 10.889  0.8913 0.084 0.012
Company 2 11.05 2024.44 0.4191 16.6622 8.6782 1.2645 0.08014 0.0507
Company 3 33.1 2970.229 0.4677 8.19318 6.2079 2.1457 0.20169 0.1799
Company 4 15.35 1906.305 -0.5647 10.5005 8.52  0.8801 0.08092 0.143
Company 5 17.95 2233.233 0.2557 9.28366 7.5461 1.5254 0.02729 0.0281
Company 6 9.4 705.5546 0.4391 7.96765 4.8187  0.7309 0.19691 0.0664
Group Average 0.2419 10.64 7.7767 1.2397 0.11182 0.08
Group 2
Company 1 33.5 1887.188 0.5794 11.8021 6.729 1.5695 0.00678 0.016
Company 2 42.5 4062.262 0.4884 11.4512 8.049 1.3025 0.03818 0.0085
Company 3 73.813 6493.813 0.5793 7.26328 7.0651 1.9361 0.04432 0.05
Company 4 44.625 13485.68 0.4066 6.86157 9.1 1.5036 0.03535 0.0689
Company 5 30.563 3206.059 0.3612 7.47432 7.4606 1.4236 0.08864 0.0527
Company 6 57.625 11467.13 0.4899 9.7128 5.5 2.4901 0.10187 0.1007
Group Average 0.4841 9.09422 7.3173 1.7043 0.05252 0.0495
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Formatting

Price Mkt. Cap. Debt/ EV / EBITDA P/ BV ROE

1/6/2020 ($MM) Capital LTM 2020E LTM LTM 2020E

Group 1
Company 1 $14.05 $2,679 43% 11.2x 10.9x 0.9 x 8.4% 1.2%
Company 2 $11.05 $2,024 42% 16.7x 8.7x 1.3 x 8.0% 5.1%
Company 3 $33.10 $2,970 47% 8.2x 6.2x 2.1 x 20.2% 18.0%
Company 4 $15.35 $1,906 (56%) 10.5x 8.5x 0.9 x 8.1% 14.3%
Company 5 $17.95 $2,233 26% 9.3x 7.5x 1.5 x 2.7% 2.8%
Company 6 $9.40 $706 44% 8.0x 4.8x 0.7 x 19.7% 6.6%
Group Average 249% 10.6 x 7.8x 1.2 x 11.2% 8.0%

Group 2
Company 1 $33.50 $1,887 58% 11.8x 6.7Xx 1.6 x 0.7% 1.6%
Company 2 $42.50 $4,062 49% 11.5x 8.0x 1.3 x 3.8% 0.9%
Company 3 $73.81 $6,494 58% 7.3x 7.1x 1.9 x 4.4%  5.0%
Company 4 $44.63 $13,486 41% 6.9x 9.1x 1.5x 3.5% 6.9%
Company 5 $30.56 $3,206 36% 7.5x 7.5x 1.4 x 8.9% 5.3%
Company 6 $57.63 $11,467 49% 9.7x 5.5x 2.5x 10.2% 10.1%
Group Average 48% 9.1x 7.3x 1.7 x 5.3% 4.9%
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The Planning Process

e It is critical to properly plan and design a model before it can be built

e Whenever a model becomes an illegible error-prone mess, it is almost
always because the modeler didn’t properly devise a model plan

e To create a strong plan, follow these three steps:
1. Identify the major issues
2. Identify all assumptions that need to be made in the model

3. Identify the required schedules and components (see following pages)

e As part of the planning process, you should also be able to answer the
following questions:

-  What is the purpose of the model?
- Which assumptions should become scenarios?
- How much detail is required?

- Do I have enough historical detail to validate the amount of forecast detail that is
required?

- What is the important output that the client wants to know?

- What metric is used to measure results?

- How many time periods should be included in the forecast? Why?
-  What is the most logical order to present the data?

© 2006 The Marguee Group Inc. 12 H/E\R UEE
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Information Gathering

Gathering the right information is one of the most difficult and

important parts of the modeling process

A good model can help to define the problem and the process
Don’t assume that the information provided is the right level of detail
A good financial analyst:

asks the right questions and determines the right level of detail required to
solve the problem

needs to be a critical thinker and realizes that a good financial model
facilitates this

uses the model to facilitate the organization and flow of the analysis

keeps the key players engaged in the process through regular updates and
by soliciting feedback

e The model is a means to an end, and not an end in itself

e A model needs to be a powerful communication tool to convey all of
the information regarding a particular analysis
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Components of a Financial Model

e Every financial model is made up of worksheets and schedules that fall
into the following three categories

e Not all models require every worksheet or schedule listed below, and
some models will require other schedules

INPUTS AND OUTPUTS FINANCIAL STATEMENTS SCHEDULES
e Model Cover e Income Statement e Revenue Schedule
e Summary Output Values e Cash Flow Statement e Costs Schedules
e Inputs / Assumptions e Balance Sheet e CAPEX / Depreciation
Schedule

e Sources and Uses of Capital

. e Fixed Asset Schedule
e Scenarios

e e Income Tax Schedule
e Sensitivity Tables
e Working Capital Schedule
e Debt and Interest Schedule

e Shareholders’ Equity
Schedule

¢ Valuation Schedule
e WACC Schedule

© 2006 The Marguee Group Inc. 14 H/E\R UEE
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Important Modeling Tips

e The following are some important tips to adhere to when creating a
financial model:

Nou AN e

@

9.

10.
11.
12.
13.
14.
15.
16.

Use a manageable number of worksheets (5 to 10 if possible)

Keep all inputs and assumptions together, and make sure inputs are ALWAYS blue
Never enter the same input twice

The model should be flexible so that inputs and assumptions can easily be tested
If possible, put all financial statements and schedules on the same worksheet

Do not insert blank columns between years

Within each worksheet, each year MUST ALWAYS be in the same column when there are
multiple schedules beneath one another

Include the model title and worksheet title prominently on every page

Label every row — have one column that’s used just for row labels

Include the date and time, page numbers and the file path on every page

Incorporate a “live” scenario tag on every page

Never delete a cell, row or column until you have determined where it flows (Auditing)
Do not make multiple copies of the model with minor revisions — use scenarios

Think about how the model will be printed and make sure the data is in page-size units
ALWAYS review your model on paper before delivering it to your colleagues or the client
Format your model as you go - don’t wait until the very end!
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Inputs and Outputs Schedules

e Well-designed and clearly-articulated Inputs and Outputs Schedules are
critical components to properly communicating your model

e If the modeler does a good job preparing the Input and Output
Schedules, the reader will have a complete understanding of the model

e The following are some of the Inputs and Outputs Schedules that can
be incorporated into most models:

Cover Page: Labels the model and adds a level of confidentiality.

- Summary Values: This is what the client wants to see! Don’t keep them in
suspense until the very end. The actual Output values will
differ depending on the model and the situation (ie. DCF
values, IRRs, Credit ratios, etc...).

- Inputs / Assumptions: Allows the modeler to communicate all of the important inputs
and drivers in one place. If an Inputs Schedule isn’t used, the
reader may overlook important assumptions.

- Scenarios: Every model will have a few inputs that are critical to
assessing the company’s value. These inputs should be
incorporated into scenarios.

- Sensitivities: Another type of output table. Allows you to test the impact of
changes to specific inputs on the model’s results.
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Custom Formatting a Cell

e Applying custom formatting to cell values is very important to ensure
that a cell’s contents are clear to the reader

- Bring the Format Cells dialogue box onto your screen (press Ctrl + 1) or:

Excel 2010 Excel 2016
» Home [H] » Format [O] » Format Cells [E] » Home [H] » Format [O] » Format Cells [E]

- On the "Number” tab, click the “"Custom” option at the bottom of the list
- In the “Type” list on the right, select the number format you want to edit
- To create a new format, click in the white space under the word “Type”

- The following rules apply to creating a custom number format:

e A zero or a number sign (#) is a placeholder for a number

- a # displays only significant digits, whereas a zero in the custom format box displays
insignificant zeros if a number has fewer digits than there are zeros in the format

e You can specify up to four sections of format codes. The format codes, separated by
semicolons, define the formats for positive humbers, negative numbers, zero values,
and text, in that order.

e If you would like a number to begin or end with a single character (ie. 5.6x), enter
the character before or after the number placeholder (ie. enter 0.0x)

e If you would like a number to begin or end with more than one character (ie. 25
years), enter the text in quotation marks (ie. enter 0.0 “years”)

e To include a comma separator, enter #,### (12000 will appear as 12,000)

e A comma at the end of the humber placeholder will divide the number by 1000 (ie.
12000 will appear as 12)

© 2006 The Marguee Group Inc. 17 H/E\R UEE
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Connecting Strings of Data

e Connecting strings of data is critically important when creating inputs
or assumptions pages, or when adding footnotes to tables

Concatenate Function

= CONCATENATE(“text1”,A1, “text2"...)

- Joins text strings and cell references into one text string
- Especially useful for assumptions pages or footnotes to tables
- This function does not extract formatting from a cell being referenced

- Formatting needs to be done manually, or by using the TEXT function
e Manual: =CONCATENATE("The tax rate used in the model is ", E20*100,"%")

e TEXT Function: =CONCATENATE(“The dollar amount is ", TEXT(E21,"$0.00"))

Ampersand “"&”

- The same functionality as the CONCATENATE function

- Connects or concatenates multiple text strings and/or cell references to
produce one continuous text string

e e.g. ="The tax rate used in the model is "&E20*100&" %"

© 2006 The Marguee Group Inc. 18 H/E\R UEE
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Creating Scenarios

e IF statements are very powerful logical formulas that are used
frequently in financial models
- An IF Statement is a very powerful modeling tool
- The IF Function is one of 6 logical operators
- IF Statements follow an IF, THEN, ELSE, pattern
=IF(B5>10,G5,H7)
=IF(C30-C60=0,"OK","ERROR")
- Embedded (or Nested) IF Statements allow you to include more than one IF
statement in a single formula

- Embedded IF Statements can be used to create switches for assumption
scenarios

=IF(C5=1,D6,IF(C5=2,D7,IF(C5=3,D8,D9)))
— Other logical operators, such as AND and OR, can be used in conjunction

with IF Statements to create even more elaborate formulas (e.g. debt
repayment schedules)

© 2006 The Marguee Group Inc. 19 H/E\R UEE
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Creating Scenarios

e The Choose function is a simpler and cleaner way of creating scenarios
than using an IF Statement

= CHOOSE(Index_num,Valuel,Value2,...)

- The Choose function chooses a value from a list of values, based on an
index number (a switch)

- The switch must always simply be a number in a cell
- The following diagram describes the CHOOSE function

Choose Function Example

A | B | C | o | E | F | 6 |
1
2 Switch:[ 1| =CHOOSE(B2,D4,D5,D6)
3
4 Base Case 10%
5 Best Case 20% Blue Input Cells
6 Worst Case 30%
7

— Cell D2 contains the CHOOSE function. The function is first looking at the switch cell
(B2). Since the switch cell contains a 1, the CHOOSE function is extracting the
contents of cell D4, the first argument in the CHOOSE function after the switch cell
reference. If the user changes cell B2 to a 2, cell D2 would change to 20%, the
contents of cell D5.

© 2006 The Marguee Group Inc. 20 H/E\R UEE
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Running Scenarios

Incorporating Pull Down Menus

To create a more user-friendly interface on a scenario switch, a pull down
menu can be used to control the CHOOSE function

A pull down menu restricts the values that can be entered into the switch
cell, thereby reducing the possibility of causing an error

Bring the Forms toolbar onto your screen by doing the following:

Excel 2010: > File [F] » Options [T] » Select the “"Customize Ribbon” box
» Put a check in “"Developer” Tab box » Click Developer menu up top
» Click the “Insert” button

Excel 2016: » File [F] » Options [T] » Select the “"Customize Ribbon” box
» Put a check in “"Developer” Tab box » Click Developer menu up top
» Click the “Insert” button

Click on the "Combo Box (Form Control)” button and use the crosshair to
draw a combo box on your screen

While the Combo Box is selected, right click and go to » Format > Control

e On the “Control” tab, select the range of cells containing the names of the various
scenarios in the “Input Range” box

e On the “Control” tab, enter the switch cell in the “Cell Link"” box

Click OK, then Use your mouse to pull down the arrow and run the scenario

© 2006 The Marquee Group Inc. 21
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Auditing Cells

Auditing
Excel 2010 Excel 2016
» Formulas [M] » Within the Formula Auditing » Formulas [M] » Within the Formula Auditing
section you will be able to access the tools. section you will be able to access the tools.

- The auditing tools are very important when creating large models

- Auditing allows you to trace a particular cell’s precedent and dependent
cells

- Double clicking on a coloured line will move the cursor to the referenced
cell

— NEVER delete a cell, row or column in a financial model before using the
Auditing tool to trace its dependents

© 2006 The Marguee Group Inc. 22 H/E\R UEE
GROUP



Revenue Schedule

e Companies either have existing revenues, or they expect to have
revenues at some point in the future

e In addition, every company’s revenues have two broad components:
- Revenue per unit

— Number of units sold

e Within a financial model, it is generally preferable to create a revenue
schedule than to simply grow the company’s revenues by a growth
factor

e Constructing a revenue schedule allows the modeler to forecast the
price and volume components independently of one another

e Another way to calculate revenues in some instances is to forecast the
size of the overall market, and the company’s market share within the
market

© 2006 The Marguee Group Inc. 23 I HRR@EE
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Cost Schedules

e Cost schedules can range from being very short and simple to being
extremely long and complex

e There are two main categories of costs:
— Variable Costs: Increase in direct proportion to the company’s sales volume

- Fixed Costs: Are not directly proportional to the firm’s sales volume

e It is usually helpful to present all of the company’s costs on both a cost
per unit basis and on a total dollar basis

e Variable costs should always be forecast and inflated on a unit basis,
and subsequently multiplied by the total number of units to arrive at
the aggregate cost of the particular variable cost item

e Fixed costs should always be forecast and inflated on a total dollar
basis and subsequently divided by the total number of units to arrive at
the unit cost of the particular fixed cost item

© 2006 The Marguee Group Inc. 24 I H/E\R UEE
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Income Statement

e None of the Income Statement line items should be calculated directly
on the income statement

e Rather, in a good model, all of the income statement line items will be
drawn from one of the schedules in the model

e It is important to have a few years of historical income statement data
to allow the reader to assess whether the forecast is reasonable

e The income statement should also include some profitability ratios to
help the reader assess whether the forecast is reasonable
(ie. EBITDA margin, EBIT margin)
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Cash Flow Statement

e Much like the Income Statement, the line items on a Cash Flow

Statement should be drawn from other statements or schedules

e A Cash Flow Statement typically has three sections:

Cash Flow Statement Line Items

Section

Line Item

Drawn From

Operating Activities

e Net Income
e Depreciation and Amortization
e Deferred Income Taxes

e Change in working capital

e Income Statement
e Income Stmt or Dep’n Sched

e ITncome Statement or Income Tax
Schedule

e Working Capital Schedule

Investing Activities

e Capital Expenditures
e Purchase or sale of assets

e Assumptions or Fixed Asset Schedule

e Assumptions or Fixed Asset Schedule

Financing Activities

e Debt Issuance or Repayment
e Dividend Payments

e Equity Issuance or Share Buy Back

e The CHANGE line on the Debt Schedule
¢ Income Statement or Shareholders’

Equity Schedule
e Shareholders’ Equity Schedule

© 2006 The Marguee Group Inc.

26

MARQUEE
GROUPQ



Balance Sheet

e Typically, the balance sheet is prepared last when creating a financial
model

e If the model is disorganized and poorly designed, the balance sheet
can be extremely difficult and frustrating to create

e People often spend hours or days trying to balance the balance sheet
e To begin, enter one historical year that is perfectly balanced

e The trick to “balancing” the forecast years is to have an organized
model, and to make sure that every line item on the cash flow
statement is captured on the balance sheet

e A balance sheet should always include a “check” line at the bottom

e If the balance sheet is off by the same amount every year, there is
probably only one error or omission that needs to be found

e However, if the balance sheet is unbalanced by different values every
year, there may be a number of problems that need to be corrected

© 2006 The Marquee Group Inc. 27 I HRR@EE
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Depreciation Schedule

A Depreciation Schedule is usually designed as a “waterfall” schedule

e The depreciation expense every year will include depreciation on
existing assets plus depreciation on new assets (Capex) that were
purchased during the year

e In the year that a capital expenditure is made, the asset should be
depreciated for only the portion of the year that the asset was owned

e As a general rule, half of the normal depreciation amount is taken in
the first year that an asset is purchased
e The most common depreciation methodologies are:

— Straight Line: The same amount of depreciation is taken every year

- Declining Balance: The same percentage is applied to the outstanding fixed
asset balance every year

e The Capital Expenditure forecast needs to appear vertically on a
Depreciation Schedule

- The HLOOKUP function is a great function to use to show the Capex forecast
vertically (see next page)

© 2006 The Marguee Group Inc. 28 H/E\R UEE
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Creating a Depreciation Schedule

e The HLOOKUP (horizontal lookup) Function is an extremely helpful
function to use when creating a Depreciation schedule

= HLOOKUP(Lookup_value, Table_array, Row_index_num, Range_lookup)

- The HLOOKUP function is very similar to the VLOOKUP function except instead of
searching in the leftmost column of the table, the HLOOKUP function searches for a
value in the top row of the table, and then returns a value x number of rows beneath

the top row
e Lookup_value: This is the item you are searching for. This item must be
found in the first row of the table.
e Table_array: The entire table in which you are searching for the data.

e Row_index_num: When Excel finds the item you are searching for (the
Lookup-value) in the first row of the table (the
Table_array), it will move a certain number of rows
down to extract the data that you are looking to retrieve.

e Range_lookup: To find a close match, type TRUE (or omit).
To find an exact match, type FALSE.
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Absolute References

e The ability to create formulas with absolute references is extremely
important when manipulating data and building financial models

- By default, Excel uses relative referencing

- Absolute references allow you to “freeze” a reference to a particular cell,
row or column by inserting dollar signs in front of the row reference, the
column reference or both

- As seen in the following example, if a formula references cell A1 and you
copy that formula down two rows and over two columns, the following
references will result

Formula Being Copied Cell Reference and Description
A B ‘ C | D Reference Description Changes to
1 =$A%$1 (absolute column and absolute row) =%$A%$1
2 \ =A$1 (relative column and absolute row) =C$1
3 =$A1 (absolute column and relative row) =%$A3
4 =Al (relative column and relative row) =C3

- To insert the dollar signs more quickly while editing a formula, use the F4
key to toggle between the various absolute referencing options
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Income Tax Schedule

e An Income Tax Schedule is used to reconcile the difference between
the two ways that a company is required to calculate its income taxes

- Accounting Rules: Income tax calculations are based on accounting rules
- Gov't Tax Rules: Income tax calculations based on government rules

e The two main differences between the methods are summarized below:

- The government typically allows a company to accelerate its depreciation
expense on new assets, which reduces the company’s taxable income
(depreciation based on government rules is called Capital Cost Allowance
(CCA) in Canada and Tax Depreciation in the U.S.)

— The government also allows companies to use losses from previous years to
offset earnings in the current year (called Tax Loss Carry Forwards “TLCF”,
or Net Operating Losses "NOL")

o If taxes calculated under accounting rules are greater than what the
government says is payable in the current period, a deferred tax
liability is created and added to the balance sheet

e Tax accounting rules vary by region and by industry, so check carefully
before using an existing tax schedule as it may not be suitable for your
situation
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Income Tax Schedule

e Income Taxes based on accounting rules are calculated as follows:

- Earnings Before Tax (EBT) on the Income Statement multiplied
by the Tax Rate

— This calculation results in the Total Income Tax line that appears on the
company’s Income Statement

e Income Taxes based on Government rules are calculated as follows:
- Adjusted Earnings Before Tax multiplied by the Tax Rate

- The formula above calculates the Current Tax line that appears on the
company’s Income Statement

- The Adjusted Earnings Before Tax adjusts the EBT on the Income Statement
for the two calculations described on the previous page (CCA / Tax
Depreciation and Tax Losses)

- The difference between the Total Tax (as calculated according to accounting
rules) and the Current Tax (as calculated according to government rules)
equals the Deferred Tax line that appears on the company’s Income
Statement

e It is important to accurately forecast a company’s current and deferred
taxes because this can have a meaningful impact on cash flow
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Income Tax Schedule

e The following table provides a numeric example of the tax concepts
described on the previous two pages.

Company A Tax Calculations

Row Line Item Calculation Notes
Accounting Calculations
1. Earnings Before Tax $100 EBT on Company A's Income Statement
2. Tax Rate 35% Company A's Tax Rate
3. Income Tax $35 EBT multiplied by the Tax Rate
Gov't Calculations
4, Earnings Before Tax $100 EBT on Company A's Income Statement
5. Adjustment: CCA / Tax Dep'n ($40) The amount by which the CCA / Tax Dep'n exceeds the Acct. Dep'n
6. Adjustment: Tax Losses ($30) Company A's Tax Losses which are available and used
7. Adjusted EBT $30 EBT Adjusted for rows 5 and 6
8. Tax Rate 35% Company A's Tax Rate
9. Income Tax $10 Adjusted EBT multiplied by the Tax Rate
Taxes as Appearing on Income Statement
10. Current Income Tax $10 Equal to row 9
11. Deferred Income Tax $25 The difference between row 12 and row 10
12. Total Income Tax $35 Equal to row 3
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Working Capital Schedule

e Working capital is the non-interest bearing current assets and current
liabilities that a company requires to run its business

e The most common types of working capital are: Accounts Receivable,
Inventories, and Accounts Payable

e Working capital affects cash flow because if a company is growing, it
may need to increase its receivables and inventories which requires
cash, thus preventing the cash from being used for other purposes

e Working capital balances are generally calculated based on an average
number of days Sales (A/R) or Cost of Goods Sold (Inv and A/P)

- A/R Balance = Sales x Days in Accounts Receivable
365

- Inv. Balance = COGS x Days in Inventory
365

- A/P Balance = COGS x Days in Accounts Payable
365

© 2006 The Marquee Group Inc. 34 I HRR@EE

GROUP



Modeling a Company’s Capital
Structure
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Modeling a Capital Structure

e Modeling a company’s debt and equity is often the most difficult part of
any financial model

e To effectively model a company’s capital structure, whether simple or
complex, the following steps should be followed:

— Clearly layout all debt and equity assumptions in the assumptions section;

- Organize the Debt Schedule so that each piece of debt has its own section
on the Debt Schedule;

- Each section of the Debt Schedule should be organized in the same way;

- The Shareholders’ Equity Schedule should be organized such that each
component of the equity has its own section.

e These points will be described in greater detail on the following pages

o If the steps above are adhered to carefully, the cash flow statement
and balance sheet will be very easy to create
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Debt and Interest Schedule

e When modeling an entire company with debt on its balance sheet, a
Debt and Interest Schedule is required

e A Debt and Interest schedule is generally not required if the company
being modeled has no debt (ie. a division or business unit)

- The Debt and Interest Schedule calculates the change in cash and debt
balances each year, along with the interest income or interest expense
incurred on the various pieces of debt

- The interest expense on each piece of debt is typically calculated as the
interest rate multiplied by the average amount of debt outstanding at the
beginning and the end of the year

- Each piece of debt should have its own section that is laid out as follows:

Beginning Balance: - equal to the ending balance of the previous year
Change during the Period: - different for each piece of debt

Ending Balance: - beginning balance plus the change during the period
Interest Rate: - either fixed or variable

Interest Expense: - interest rate times the average debt in the period
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Senior Debt

e Senior Debt represents the components of a company’s debt that have
first claim on the company’s cash flows

e Senior Debt is also typically secured by the company’s assets

e Within a financial model, the most typical forms of senior debt are:
- Senior Term Debt; and
- Revolving Credit Facility

e The two types of senior debt above are provided by a bank’s corporate
or commercial banking departments

e Senior Term Debt and Revolving Credit Facilities will be described in
greater detail on the subsequent pages
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Senior Term Debt

e Senior Term Debt represents the primary product offered by a bank’s
corporate and commercial banking departments

e Term Debt is typically amortized each year, with a bullet repayment at
the end of the term

- The amortization can be either straight line (ie. 10% of the initial loan
amount each year), or accelerated (ie. a 5-year loan could be amortized 5%
in year 1, 10% in years 2 and 3, 15% in years 4 and 5, and a bullet
repayment at the end of year 5)

- The interest rate on the Term Debt is often variable and is commonly set at
LIBOR plus a spread

— Term Debt is often the simplest component of the debt schedule because the
repayment amounts are known with certainty for each year of the forecast
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Revolving Credit Facility

e Revolving Credit Facilities are usually structured and provided by banks
to provide companies with cash for working capital needs

- A Revolving Credit Facility is also sometimes known as a Revolver, a Bank
Line or an Operating Line

- It is called a Revolver because it is often structured with a “sweep”
provision, and therefore functions like a revolving door:

o If the company experiences a cash shortfall, it can borrow from its revolver, up to
the maximum amount set by the bank; and

o If the company generates excess cash, the bank will “sweep” all or part of the
excess cash to pay down any outstanding balance on the revolver

- A revolver is an integral part of any financial model because it highlights
how the company’s debt will change depending on the operating
assumptions that are being made in the model

— A revolver is also critical from a mechanical standpoint because it forces a
financial model to stay balanced by automatically calculating the cash
shortfall, or excess cash generated each year

- The interest rate on the outstanding revolver balance is typically equal to
the interest rate on the company’s Senior Term Debt
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Calculating the Revolver

e Calculating the change in the revolver each year can be the most
complicated and difficult part of any financial model

Since the Revolver needs to increase OR decrease, many bankers use a
complex nested IF statement to model the change in the revolver

Using a nested IF statement is very tricky, and the formula will often not
work properly under all circumstances

Fortunately, there is a much simpler way to calculate the change in the
Revolver, and it requires using Excel’s MIN function

To calculate the change in the Revolver, you need to know three values:

1. FCF After Mandatory Debt Repayments
This represents the cash shortfall or cash surplus during the year and it is typically calculated as:
Operating CF + Investing CF — Mandatory Debt Repayments - Dividends (if these take priority
over the revolver)

2. Beginning Cash Balance
This is the Company’s cash balance at the Beginning of the period

3. Beginning Revolver Balance
This is the outstanding Revolver balance at the Beginning of the period

The calculation of the change in the revolver is simply:
=-MIN(FCF p¢ter Mand Debt Rpmts + B€g Cash Bal, Beg Revolver Bal)

THE
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Calculating the Revolver (contd)

e The following example proves that the simple formula at the bottom of
the previous page works under all scenarios:

Example of Revolver Calculation

Year 1 Year 2 Year 3 Year 4
FCF atter Mand Debt Repay (10) 6 12 (14)
Beg. Cash Balance 0 0 0 8
Beg. Revolver Balance 0 10 4 0
[MIN Formula Returns: 10 (6) (4) 6 |

- In year 1, the company is forecasting FCF of (10). The MIN formula returns +10, which
means that the company needs to borrow $10MM from its revolver.

- In year 2, the company is forecasting FCF of +6. The MIN formula returns (6), which
means that the company will repay $6MM towards its revolver, thereby reducing its
revolver balance to $4MM at the end of the year.

- In year 3, the beginning revolver balance is 4 and the company is forecasting FCF of
+12. The MIN formula returns (4), which means that the company will repay the
remaining balance on its revolver. Even though the company is forecasting to generate
FCF of +12, it will never repay more than it owes on the revolver.

- In year 4, the company now has $8MM of cash in the bank at the start of the year and is
forecasting to generate FCF of (14). The MIN formula returns +6, which means that the
company will borrow +6 from its revolver. The company will use its own cash reserves
before borrowing from its revolver.
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Revolver Circularity

e Revolving Credit Facilities make financial models circular for the
following reason:

To calculate the interest expense each year on the Revolver, the formula is:
Int. Expense = Int. Rate x Average (Beg. Revolver Balance, End. Revolver Balance)

This formula implies that to calculate the interest expense on the revolver, we must know
the interest rate, the beginning revolver balance and the ending revolver balance

The interest rate and beginning revolver balance are obviously known with certainty

However, how can we know how much revolver debt is going to be outstanding at the
end of each period?

The reason we don’t know how much revolver debt is going to be outstanding at the end
of each period is because depending on the amount of the interest expense, there will be
more or less cash flow available to repay the revolver

So, to calculate the Interest Expense on the Revolver, we need to know what the ending
balance is going to be at the end of the period

However, in order to know what the ending balance is going to be, we need to know the
interest expense on the revolver during the period

Both formulas depend on knowing the answer to the other formula, and therefore, the
logic is circular

This is not typically an issue with Term Debt because with Term Debt, the repayment
schedule is usually based on a pre-set amortization schedule, and as a result, the
repayments and ending balances each year are known with certainty
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Circular References

e As described on the previous page, a revolving credit facility will make
a model circular

- A circular reference occurs when a formula refers to itself, either directly or
indirectly

— Circular references are REQUIRED in models with a Debt and Interest
Schedule

- The circular argument for a Revolving Credit Facility can be resolved
iteratively, so you need to turn on the Iteration option within Excel

Excel 2010: > File [F] » Options [T] » Select the “Formulas” box - check Enable
Iterative Calculation

Excel 2016: > File [F] » Options [T] » Select the “Formulas” box - check Enable
Iterative Calculation

- If a financial model becomes circular accidentally, use the Circular
Reference Toolbar to find the problem cells

Excel 2010: > Formulas [M] » Error Checking [K] » Circular References [C]
Excel 2016: > Formulas [M] » Error Checking [K] » Circular References [C]
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A Revolver’s Circular Path

e The following diagram illustrates the path of the circular reference
caused by the Revolving Credit Facility

Debt Schedule
-Revolver Ending Balance

-Revolver Interest Exp.

¢

Income Statement

-Total Interest Expense

-Net Income

4

Cash Flow Statement

-Cash From Operations

-Free Cash Flow
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Shareholders’ Equity Schedule

e A Shareholder’s Equity schedule is generally required when preparing a
model for an entire company

e When preparing a model for a division or a particular asset (ie. a
manufacturing facility), a Shareholder’s Equity Schedule may not be
required

- Much like the debt schedule, each of the following equity components should
have its own section on the Equity Schedule:

e Preferred Shares
e Common Shares
e Retained Earnings

— A Shareholders’ Equity Schedule is particularly helpful in situations where
any of the following issues are present:
e Dividend Payments;
e Equity Issuances;
e Share Buy-Backs;
e Necessity to track shares outstanding;

e Stock Options.
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Fixing Error Messages

e When an Excel file becomes circular, errors are more common

- The following are the most common error message, their meaning and how
to fix them

#NAME: The #NAME? error value occurs when Microsoft Excel
doesn't recognize text in a formula - Fix the Formula

#VALUE!: The #VALUE! error value occurs when the wrong type of
argument or operand is used - Fix the Formula

#NUM!: The #NUM! error value occurs when a problem occurs with a
number in a formula or function - Fix the problem number

#DIV!: The #DIV/0! error value occurs when a formula divides by 0 (zero)
- Make sure the formula doesn’t divide by zero

#REF!: The #REF! error value occurs when a cell reference is not
valid. The #REF! errors are the most difficult to fix.

- To fix a model that has #REF! errors:

First, search the entire file for the #REF! term to ensure that there are no actual #REF! references
within any formulas

If there are not, copy the interest expense and interest income lines off to the right (outside the
last column)

Delete the contents of the interest expense and interest income lines

Continue deleting the contents of rows in the circular loop within the model until all the error
messages are gone

Copy the formulas back into their appropriate cells

THE
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Printing a Model

e If a model has been designed logically and is well laid out, it will be
much easier to print
Excel 2010 Excel 2016
» Page Layout [P] » Page Setup [SP] » Page Layout [P] » Page Setup [SP]

— Go to the tab called “Sheet” and highlight the print ranges within the “Print
Area” box
- Print ranges must be separated by a blank row or column
Excel 2010 Excel 2016
» File [F] » Print [P] » Print Preview [V] > File [F] » Print [P] > Print Preview [V]
- If selected ranges do not fit properly, you need to:
e Go the tab called "Margins” in Page Setup and adjust the page margins; and/or
e Go to the tab called “"Page” in Page Setup and adjust the scaling; and/or
e Adjust the spacing of lines and columns on the worksheet

Excel 2010 Excel 2016
» View [W] » Page Break Preview [I] > View [W] » Page Break Preview [I]

- An alternative way to select print ranges

e To print multiple sheets simultaneously, select all desired sheets (Ctrl +
Shift + PageUp) and then print
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